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Abstract
EFI Colorproof XF was found to be more convenient from a user’s aspect, and had features which are covered 
in the ISO 12647-7 standard (e.g. the ability to simulate screening and print margin information), which 
Photoshop CS3 lacked. None of the proofing systems distinguished itself in a clear way from the other; some-
times, on certain substrates, Photoshop CS3 produced most accurate colours, sometimes EFI Colorproof XF 
did. Further investigations need to be carried out to tell more exactly which system produce most accurate 
colours.

Only 6 out of 34 simulation-combinations had colours within the tolerances in the standard. The result also 
shows that the production substrates should not be used as proofing substrates. Instead the proofing papers 
especially made for ink jet should be used to obtain more colour-accurate prints.
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Summary
The aim of this project was to evaluate EFI Colorproof XF v. 3.1 and Photoshop CS3 as hard proofing systems 
concerning colour accuracy when evaluating ICC-profiles (custom-made by Kvarnsveden Mill, Borlänge, 
Sweden, to their customers and their unique printing process), using seven different proofing substrates (of 
which three were production substrates) in an ink jet printer. Also, the two systems’ technical ability to meet 
the objectives in ISO 12647-7:2007 (which was used as a canon in this project) was briefly discussed.

A control strip was assigned four different ICC-profiles, printed on each substrate in each system and the 
difference between the digital reference and the reproduced colours was calculated and compared to the toler-
ances in ISO 12647-7:2007.

EFI Colorproof XF was found to be more convenient from a user’s aspect, and had features which are cov-
ered by the standard (e.g. the ability to simulate screening and print margin information), which Photoshop 
CS3 lacked. Sometimes, on certain substrates, Photoshop CS3 produced most accurate colours, sometimes 
EFI Colorproof XF did. The two systems did however produce slightly different colour gamuts. Further inves-
tigations need to be carried out to tell more exactly which system produce most accurate colours.

Only 6 out of 34 simulation-combinations had colours within the tolerances in the standard, 5 being very 
close. The result also shows that the production substrates (standard newsprint, super-calendered paper and 
improved newsprint, for offset and rotogravure) did not obtain gamuts that were large enough to confine the 
used ICC-profiles. Instead the proofing papers especially made for ink jet should be used as colour proofing 
substrates. 

Nevertheless, as the production substrates have other qualities which cannot be simulated on ink jet paper 
(e.g. opacity, shade, roughness, thickness etc.), it is recommended that they are used as well, but not when 
evaluating colours.

It is recommended that Photoshop CS3 is used for a start as proofing system, as the software is already avail-
able at the Mill. EFI Colorproof XF could be used if it’s later found to be more convenient.
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Sammanfattning på svenska
Målet med projektet var att utvärdera EFI Colorproof XF v. 3.1. och Photoshop CS3 som system för provtryck 
sett ur färgreproduktion för utvärdering av de ICC-profiler som Kvarnsvedens Pappersbruk skapar unikt för 
sina kunder. I undersökningen användes sju olika provtryckssubstrat i brukets inkjet-skrivare. Vidare disku-
terades i korthet de två provtryckssystemens tekniska förutsättningar att uppnå målen i ISO 12647-7:2007, 
som användes som utgångspunkt i detta projekt, och användarvänlighet.

Fyra ICC-profiler tilldelades till en kontrollstripp som sedan skrevs ut och uppmättes. Skillnaden mellan 
färgerna i utskriften och i den digitala referensen beräknades och jämfördes med toleranserna i ISO 12647-
7:2007.

EFI Colorproof XF befanns vara mer lämplig ur ett användarperspektiv och innehöll finesser som ingick i 
standarden (t.ex. förmåga att simulera rastrering och att trycka metainformation), som Photoshop CS3 sak-
nade.

På vissa substrat, gav ibland Photoshop CS3 bäst färgsimulering, medan EFI Colorproof XF, andra gånger, 
gav bäst färgsimulering. De två systemen gav dock något olika färgomfång. Ytterligare undersökningar måste 
utföras för att med större säkerhet avgöra vilket system som producerar bäst färgåtergivning.

Endast 6 av 34 simuleringskombinationer återgav färger inom toleranserna i standarden – 5 var väldigt 
nära. Resultaten visar också att produktionssubstraten (vanligt tidningspapper, superkalendrerat papper 
(SC-papper) och förbättrar tidningspapper, för offset och djuptryck) inte gav tillräckligt färgomfång för att 
täcka in de simulerade ICC-profilerna. Istället bör papper direkt framtagna för inkjet användas som substrat 
vid färgsimulering.

Eftersom produktionssubstraten besitter andra kvaliteter, som inte kan simuleras med inkjet-papper (t.ex. 
opacitet, nyans, ytråhet, tjocklek etc.), rekommenderas att dessa fortfarande används men inte vid utvärdering 
av färger.

Photoshop CS3 rekommenderas till en början att användas som provtryckssystem då pappersbruket redan 
har denna programvara till sitt förfogande. EFI Colorproof XF kan senare användas om det befinns vara mer 
lämpligt.

Nyckelord
färgprovtryck, inkjet, provtryck, ISO 12647-7, EFI Colorproof XF, Photoshop CS3, tidningspapper, SC-papper, förbättrar tidningspapper, 
färgomfång
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1 Introduction

1.1 Background

In the graphic arts industry, colour proofs are made to visualize how the 
colours of an image intended for print will look like after being printed, not 
having the image going through the actual (often costly and time consuming) 
printing process.

Instead, the printing result is simulated by a proofer, using a cheaper and 
quicker technique – for instance displayed using a colour monitor (“soft 
proofing”) or printed using ink jet (“hard proofing”). The proof is a prototype 
of the final print, one could say, making it possible to react on it before the 
real reproduction begins.

At Kvarnsveden Mill in Borlänge, Sweden, custom-made ICC-profiles are 
sometimes made for the clients who use the Mill’s paper brands in their print-
ing processes. First, a characterization colour chart is printed in the customer’s 
printing process, and from this an ICC-profile is made with different settings. 
To see how the profile behaves (e.g. when it comes to maximum black, grey 
balance, how gradients are reproduced etc.) an ink jet printer (EPSON Stylus 
Pro 3800) was obtained to print hard proofs, showing the separations obtained 
using the profile. Different settings and profiles can be simulated and evalu-
ated, before the final colour profile is shipped to and used by the customer.

1.2 Problem

For this project, Kvarnsveden wanted to see which proofing system (RIP sys-
tem) and which proofing substrates should be used together with the printer 
in order to get colour-accurate proofs. In this investigation, four different 
ICC-profiles were simulated, representing the colours obtained from ordinary 
printing conditions on similar paper types.

1.3 Goals

The goal of this project was to evaluate EFI Colorproof XF and Photoshop CS3 
as hard proofing systems when it comes to colour reproduction – to see which 
system obtained the largest gamut on each substrate and if the colour differ-
ences were within the tolerances specified in ISO 12647-7:2007 when printing 
a control strip. Very briefly, the different systems’ technical ability to reach the 
objectives in ISO 12647-7:2007 was also discussed together with the systems’ 
conveniences from a user’s aspect.

Moreover, seven print substrates were evaluated as proofing substrates using 
the ICC-profiles recommended by the Milll, and compared to three paper 
brands intended for simulation at Kvarnsveden. The most suitable substrates 
are recommended in the conclusion.
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1.4 End effects

The end effect of this report is to offer a better understanding of the proofing 
method as such, and make it easier for Kvarnsveden to simulate their custom-
made ICC-profiles locally on their proofing system, preventing the necessity 
of a second test-printing – saving both time and money.

1.5 Delimitations

The focus of this investigation lies on the differences in colour between the 
printed hard proof and the digital reference using the different combinations 
of substrates and proofing system. No visual appraisals have been conducted,  
just measurements using spectrophotometers.

One characterization chart was printed per substrate and proofing system 
(i.e. two charts per substrate, but one per proofing system), measured and 
used when profiling. When evaluating the colour accuracy, simulating the 
profiles found on page 14, one control strip/test chart per profile per substrate 
was printed and measured.

As the instruments’ repeatability seemed to be very accurate after some 
initial tests, only one measurement per chart was made.

1.6 Audience

When reading this report, the reader should know the basics of colour man-
agement. She or he should also be familiar with the concept of colour spaces 
and colour gamuts and how ICC-profiles (colour profiles) are used to describe 
the colours of a device and how these profiles are made and used to convert 
the colours from one gamut to another. In the theory section of this report this 
is discussed comprehensively.
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2 Theory and definitions
For the additional information on colour management, the books Under
standing Color Management by Abhay Sharma and Real World Color 
Management by Bruce Fraser, Chris Murphy and Fred Bunting, are truly rec-
ommended. For the fundamentals on proofing, The ABC’s of Proofing (which 
can be downloaded for free from EFI’s web site) is a good reference.

2.1 Proofing

As was said in the introduction, proofs are used to mimic how a product 
intended for print, will look like after being printed. There are different kinds 
of proofs, for different purposes. Text and layout proofs are used to check the 
text and layout, imposition proofs are used to see that the pages are placed 
correctly on the printing forme, and colour proofs are used to check that the 
colours of an image are alright, etc.

If the proof is displayed using for instance a colour monitor, it is called a 
soft proof, and when it’s printed using for instance an ink jet printer, it is called 
a hard proof. If the proof is produced using the actual printing process (typi-
cally used in digital printing processes since producing a single copy is not 
very expensive, as it is in for instance traditional offset printing), it is called 
a press proof. If the screening is simulated, the proof is called a true proof or 
a half-tone proof. During this project, only colour hard proofs using ink jet 
have been studied.

2.2 L*a*b* and L*C*ab hab

A particular colour is often described by its hue (often the same as its fun-
damental name, e.g. “yellow”, “green”, “orange”), its chroma (colloquially also 
known as saturation or colourfulness) and its lightness.

Another way of describing a colour is through the three components L*, a* 
and b* found in the CIELAB colour space, which mimics the way the human 
eye perceives colours. Here, L* is the lightness, a* is the redness–greenness 
and b* is the blueness–yellowness of the colour.

From the L*a*b* values assigned to a specific colour, it is possible to com-
pute the colour’s hue angle (hab – expressed in degrees), its chroma (C*ab) and 
lightness (L*) which are sometimes easier to relate to than the L*a*b* compo-
nents themselves. See formulae on page 20.

These L*a*b* or L*C*ab hab components can be used as coordinates to plot a 
specific colour in a three dimensional colour space.
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2.3 Colour gamut (colour range)

All the colours which a unit can replicate is called the unit’s colour range or 
colour gamut. In printing, the size of the colour gamut is determined by the 
specific printing process and the materials used – like which type of inks and 
printing substrate (paper, in this case) are used and the fixed printing condi-
tions (e.g. the chosen densities of the inks).

If all the colours that a particular unit is able to replicate are plotted in the 
CIELAB colour space, one would get a three dimensional view of the unit’s 
colour gamut – very often with a shape reminding of an iceberg, where the tip 
is the shade of the printing substrate. See Diagram 1.

Sometimes the outer gamut colours are plotted in a two dimensional dia-
gram showing just the a*- and b*-axes, not taking the lightness (the L*-axis) 
into account. This method of visualizing the gamut – known as a gamut pro-
jection – is not always the most preferable, as seen in Diagram 1.

Regardless of which proofing technique is applied, it is desirable that the 
colour range of the proofer is larger than that of the printing process to be 
simulated. If not, some colours could not be replicated accurately and the 
colour proof would not be reliable, missing its aim.

2.4 Calibration, characterization and ICC-profiles

The actual colours produced by a printing press depend on a number of fac-
tors, as mentioned earlier, like the ink film thickness, the dot gain (tone value 
increase), the paper and its shade etc.

The result is for example that a 100 % magenta patch could look quite dif-
ferent if it’s printed on a yellowish newsprint and when printed on a coated, 
glossy paper – the patch is still 100 % magenta in both cases, but the actual, 
perceived colours are not identical. The subtractive colour model used in 
printing, CMY(K), is therefore said to be device dependent – i.e. the colours 
produced are affected by the printing device and its settings.

In colour management one deals with how to get consistent colours in a 
workflow. For this, ICC-profiles are used, describing the colours reproduced 
by a certain device; may it be a printing press, an ink jet proofer, a scanner or a 
monitor, the profiles are obtained in similar ways. Still, only CMYK processes 
are studied in this project.

2.4.1 Calibration

If the colours of a printing press are to be predicted, it is essential that the 
printing process is as stable as possible: The densities of the inks need to be 
fixed, the paper must not be changed, the dot gain must be controlled etc. This 
step is called calibration (or linearization). If any of these settings are changed, 
the prediction of the output colours would no longer be accurate.

Diagram 1 – When viewing a 
gamut projection in the CIELAB  
a*–b* plane, it may appear that 
one gamut is a complete subset 
of another, but when seen in 3D 
it’s clear that it’s not. Therefore, 

gamuts are best viewed in 3D.  
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2.4.2 Characterization

The next step is to print a chart with colour patches (the CMYK values for 
these patches are defined in ISO 12642-2:2006) to show the colour gamut (see 
section 2.3) which the press can produce. These patches, defined in device 
dependent CMYK, are printed, then measured (using for example a spectro-
photometer) and “translated” to a device independent colour space like L*a*b*. 
This step is called characterization.

2.4.3 ICC-profile

What an ICC-profile essentially does, is that it uses the characterization 
data and connects CMYK with L*a*b* and thus describes which CMYK-
combination would obtain which perceived colour in L*a*b* (and vice versa). 
Making it possible to convert a picture defined in RGB to CMYK via L*a*b* 
using the corresponding ICC-profiles.

Other settings can be made to the ICC-profile as well, for instance defining 
the total ink coverage and to what extent combinations of C, M and Y should 
be substituted with K when performing separations. These settings are made 
depending on the particular printing conditions, and affect the colours when 
performing a conversion or separation to CMYK. However, the resulting col-
ours are still confined within the press’ maximum colour gamut.

In this project four typical ICC-profiles have been used as representatives of 
the actual printing conditions – in reality these ICC-profiles themselves have 
not been evaluated, but instead the proofer’s ability to reproduce the gamuts of 
the profiles. If the colour gamuts are confined within the gamut of the proofer 
and the L*a*b* values of the printed colours matches the L*a*b* values in the 
digital document, the system would produce accurate simulations – being a 
suitable tool for evaluating custom-made profiles.

It is essential that the ICC-profile made for the proofer produces good sepa-
rations with no artefacts as these could be seen in the print outs, making the 
viewer believe that the artefacts are due to the simulated profiles and not the 
proofing itself.

It is important to realize that if the printing conditions are changed, the 
profile would no longer be valid. Therefore recalibrations are sometimes done. 
Strictly speaking, the profile is only valid for the conditions at that very point 
in time when the characterization chart was printed.

2.5 Rendering intent

When translating the colours from one colour gamut to another – as is done 
when converting the colours from the gamut of a printing press to that of the 
proofer – different approaches are possible, using different translation or con-
version techniques (rendering intents).

When it comes to proofing, the absolute colourimetric rendering intent is of 
special importance as it keeps all the colours which are already confined within 
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the new gamut as they are, and moves the out of gamut colours so that they are 
just inside (i.e. changing the actual colour somewhat). Absolute colourimetric 
also makes it possible to simulate the shade of the production paper.

By using a larger gamut as the destination when doing an absolute colouri-
metric conversion, no colour shifts would take place.

Relative colourimetric rendering intent is used when the paper shade should 
not be simulated. In this project, this has only been desirable when the proof 
substrate has been identical to the production substrate.

2.5 The reference and the control strip

When viewing a proof, it is important to know how close it matches what it’s 
supposed to replicate (the reference).

When it comes to digital proofs, the references are the colours found in the 
digital document (e.g. the colours in a digital image) which has been prepared 
to be used in the actual printing process.

One way of comparing the real proofing result to the digital reference, is to 
print a control strip together with the image on each proof – i.e. a group of 
colour patches which has under gone the same colour work-flow as the image 
itself.

The colour patches in the strip is then measured using for instance a spec-
trophotometer, and the colour data is compared to the values found in the 
digital document. If the proof is perfect, there should be no difference, but in 
reality this is not possible, therefore certain variations are allowed.

Which colour patches to be included in the control strip are defined in ISO 
12647-7:2007. A strip could be made manually using for instance Photoshop 
or Illustrator (in CMYK), or be bought from for instance Fogra (the Fogra 
Media Wedge). In this project a control strip from IDEAlliance was used 
throughout the project (see Annex F). The strip can be downloaded for free 
from www.idealliance.com.

The reference values (very often in L*a*b* for each colour patch) can eas-
ily be recorded from Photoshop (using the absolute colourimetric rendering 
intent in the colour settings) or using for instance the freeware ColorLab. See 
Annexes A and B for more details on how to do this properly.

In some proofing systems, there is a special software (in EFI Colorproof XF 
it is a plug-in called Color Verifyer) in which the printed control strip can be 
compared to the digital reference, and the user being told whether or not the 
patches are within the tolerances. If many proofs are printed and measured, 
this could be a convenient solution.

When measuring the colours, it is important (mainly for substrates not 
being perfectly opaque) that the same backing is used as when making the 
media ICC-profile.
When it comes to the proofing substrate, it should match the production 
substrate (which is the reference, substrate-wise) as much as possible – e.g. in 
gloss, opacity, shade etc. – but this is not always possible.
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2.6 Colour differences

It is very often desirable to quantify how much two colour samples differ. 
Mathematically, change is often denoted using the Greek capital letter delta 
(Δ) – e.g. ΔL* means CIELAB lightness difference, ΔC*ab means CIELAB 
chroma difference etc. The CILEAB hue difference is expressed as ΔH*ab and is 
computed as shown on page 18.1 Please note that to express the change in hue 
angle, the symbol Δhab is used.

To show the total colour difference, ΔE*ab is used. It is determined as the 
Euclidean (metric) distance between two colour coordinates in the colour 
space, and is calculated as shown on page 18. There are several other ways of 
expressing the total colour difference – for instance using ΔE*2000 or ΔE*94, which 
takes into account that the human eye is more sensitive in changes in some 
areas of the colour space, and less sensitive in others – but in this report the 
metric ΔE*ab is used throughout in accordance with ISO 12647-7:2007.

2.7 The ISO 12647-series

In the international standard ISO 12647 it is specified in its different parts 
how different printing techniques shall be conducted, which tolerances (in 
for instance colour reproduction) are acceptable, and how to perform colour 
measurements, etc.

ISO 12647-7:2007 (i.e. part 7 of ISO 12647) is especially important for this 
project as it deals with proofing: How much the printed colours are allowed 
to deviate from the digital reference, which image and document formats the 
proofer shall accept, how much the colours are allowed to change over time 
(repeatability of the proofer), and what information should be printed on 
each proof (margin information). It also covers details on how to simulate 
the screening of the press, information on how much the proofing substrate is 
allowed to deviate from the production substrate, which test methods and test 
targets to use, which patches to use in the control strip etc.

2.8 Print substrates

A substrate is a generic term for the media (paper, in this case) which carries 
the inks making up the printed image.

In ISO 12647-7:2007 a distinction is made between two different print 
substrates – namely “production [printing] substrate” and “proof substrate”, 
where the former is a term for the substrate used in the printing process to be 
simulated, and the latter is used for the substrate used by the proofer.

As it says in ISO 12647-7:2007, 4.2.1 “the digital proofing substrate should, 

1 It is not explicitly stated in ISO 12647-7:2007 how to calculate the CIE hue difference, which 
is denoted ΔH in Table 2 in that standard. In ISO 13655:1996, B.3 (which is referred to in ISO 
12647-7:2007, 5.3 on how to calculate L*a*b* and ΔE*ab) the slightly different symbol ΔH*ab is 
used. In this report it is assumed that ΔH  is the same as ΔH*ab.
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if possible, be the same as the substrate to be used for production printing”. 
Therefore, three production substrates were used in addition to the four tra-
ditional proofing substrates in this investigation to see if they were sufficient 
as proof media.
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3 Apparatus and method
ISO 12647-7:2007 was used as a canon in this project, mainly because of its 
importance as international standard and its convenience from a communica-
tion point of view to Kvarnsveden’s clients.

3.1 Softwares used

The main softwares used in this investigation are
•	EFI	Colorproof	XF	v.	3.1	–	a	proofing	system	from	EFI
•	Adobe	Photoshop	CS3	v.	10.0	from	Adobe	Systems
•	ProfileMaker	Pro	5.0.8	–	including	MeasureTools	and	ProfileMaker	from	

X-Rite (former GretagMacbeth)

In addition, the following softwares were used
•	EPSON	ColorBase	v.	2.30	–	a	calibration	software	used	for	the	proofer
•	ColorLab	2.8.13	–	 a	 freeware	offered	by	X-Rite,	 used	 to	 export	L*a*b* 

data from TIF-files
•	ColorThink	 2.2	&	ColorThink	 Pro	 –	 softwares	 used	when	 plotting	 the	

colour gamuts and obtaining quantified gamut volumes (from Chromix)

3.2 Printer and inks used

EPSON Stylus Pro 3800 was used as ink jet proofer together with the standard 
inks accompanying the printer.

3.3 Substrates and simulated ICC-profiles

These substrates were used as proofing substrates during this investigation:
•	EFI	Gravure	Proof	Paper	4245	Semimatt,
•	EFI	Offset	Proof	Paper	9200	Semimatt,
•	EFI	Proof	Paper	ZP	55	(Newspaper	Proof),
•	HP	Matte	Proofing	Paper	Q1967A,
•	NewsPress	1410	–	standard	newsprint	for	offset,
•	ExoPress	5710	–	improved	newsprint	for	offset,	and
•	PubliPress	6740	–	super-calendered	magazine	paper	for	rotogravure.

The last three substrates are produced by Kvarnsveden Mill and have here 
been evaluated as proofing substrates, though initially intended for offset and 
rotogravure.
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The ICC-profiles listed below were simulated during this investigation:
•	 ISOnewspaper26v4	–	from	Ifra	(30	June	2004),
•	PSO	SNP	Paper	(ECI)	–	from	ECI	(16	June	2008),
•	PSRgravureSC	–	from	ECI	(3	September	2004),	and
•	Germany	 SNP	 –	 a	 custom-made	 ICC-profile	 from	 Kvarnsveden	 Mill	

made on NewsPress 1410.

For each combination of substrates–ICC-profiles, see Table 1 below.
The standard profiles were recommended by Kvarnsveden for the produc-

tion substrates used in this investigation.

Table 1 – Each combination of proofing substrate–ICC-profile investigated in 
this project. The table numbers show in which tables in Annex J the results are 
shown.
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EFI Gravure Proof Paper 4245 Semimatt • • •

EFI Offset Proof Paper 9200 Semimatt • • •

EFI Proof Paper ZP 55 (Newspaper Proof) • •

HP Matte Proofing Paper Q1967A • • • •

NewsPress 1410 • •

ExoPress 5710 • •

PubliPress 6740 •
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3.4 Colourimetric measurements

During the investigation, colourimetric measurements were obtained using 
two spectrophotometers – Eye-One Pro (i1 Pro – which could be connected 
to a robotic, automatic chart reader, iO) from X-Rite, and SpectroDens 
Premium (Software: 8.04 (08.10.08), Hardware number: 1) from Techkon. The 
accuracies of the instruments, as described by the manufacturers, are seen in 
Annexes C and D.

All the colourimetric measurements were conducted using D50 illuminant, 
2° observer, 0°/45° or 45°/0° geometry and absolute white reference – no 
polarisation filter.

Although it was later found out that the calibration due date for i1 Pro had 
passed by 4 months, the measurements corresponded very well to the ones 
obtained from SpectroDens. Thus the data can still be regarded as fairly accu-
rate.

3.5 Relative density measurements

When determining the tone value increase during the linearization process 
in EFI Colorproof XF, SpectroDens was used with the polarisation filter acti-
vated, density filter DIN 16536 and zeroing against the substrate.

3.6 Backing

A black piece of paper was used as backing when measuring the shades of the 
proof substrates to the substrate data found in the ISO 12647-series and when 
measuring the tone value increase in EFI Colorproof XF.

In all other cases, including when charts for linearization and characteriza-
tion were measured, white backing (confirming to ISO 12647-7:2007, 5.3) was 
used.2

3.8 Colour charts used for characterization

The characterization chart IT8.7-4 (conforming to the randomized expanded 
characterization data set of ISO 12642-2 with 1617 patches) for iO was printed 
from Photoshop CS3 and used when profiling each substrate in ProfileMaker 
5.0. In EFI Colorproof XF, the IT8 chart with 928 patches was used through-
out, except for EFI Gravure Proof Paper 4245 where the IT8.7-4 chart was 
used.

2 The white plastic backing table included with i1 Pro did not completely conform to the 
requirements of ISO 12647-7:2007, 5.3. Instead the white backing from the iO was used 
throughout the project.
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3.9 Patches used during evaluation

In ISO 12647-7:2007, 5.1 it is specified which patches should be used in the 
digital CMYK control strip which always must be printed on every proof. The 
control strip must be colour managed in the same manner as the rest of the 
proof in order to measure the validity of the reproduced colours. Here, the free 
control strip offered by IDEAlliance was used (see Annex F), along with the 
tolerances found in ISO 12647-7:2007, 4.2.2 and in ISO 12647-7:2007, Table 
2.

When measuring the validity of the simulation of the custom-made 
Germany SNP-profile, all patches in ISO 12642-2 (using the T8.7-4 test target 
for iO from ProfileMaker) were printed together with the IDEAlliance control 
strip and compared to the reference data. The tolerances used are specified 
below.

Table 2 – The tolerances for proofs found in ISO 12647-7:2007.

ISO
tolerance

Simulated print substrate colour ΔE*
ab ≤ 3

100 % C ΔE*
ab ≤ 5

ΔH*
ab ≤ 2,5

100 % M ΔE*
ab ≤ 5

ΔH*
ab ≤ 2,5

100 % Y ΔE*
ab ≤ 5

ΔH*
ab ≤ 2,5

100 % K ΔE*
ab ≤ 5

ΔH*
ab ≤ 2,5

All patches in control strip maximum ΔE*
ab ≤ 6

average ΔE*
ab ≤ 3

Grey balance patches average ΔH*
ab ≤ 1,5

Outer gamut patches average ΔE*
ab ≤ 4

All patches of ISO 12642-2 average ΔE*
ab ≤ 4

95 % percentile ΔE*
ab ≤ 6

How the reference data was collected from each simulated ICC-profile is 
described in detail in Annex B.
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3.10 Printing and storing environment

The printer was placed in the climate stabilized testing laboratory at Kvarn-
sveden, having a temperature of (23 ± 0,5) °C and a humidity of (50 ± 2) %. 
The papers were kept in dark in the same environment.

3.11 Settings in the EPSON printing setup window

Before printing using EFI Colorproof XF and Photoshop CS3, tests were made 
trying different settings in the EPSON printer’s printing settings window. It 
was shown that changes made did not affect EFI Colorproof XF, but did have 
an impact on the print outs from Photoshop CS3.

3.12 Settings and the creation of the media profiles in EFI Colorproof 
XF v. 3.1

3.12.1 Base linearization

Before creating the ICC-profiles in EFI Colorproof XF, a base linearization of 
the printer using the specific media (substrate) intended for printing had to 
be carried out. The linearization in EFI Colorproof XF is a five-step-procedure 
where test targets are printed and measured. The layout of the test targets 
varied depending on the selected measuring tool and it was evident that each 
step affected the following. During the linearization procedure, the handheld 
i1 was found to be most convenient as re-measurements had to be made.

The steps in the linearization process included the determination of the 
total ink limit and the ink limit per channel, which is normally controlled by 
the ICC-profile and not in the linearization.

In the second last step (step 4: “Linearization”) it was possible to determine 
the tone value increase (dot gain) of the print-out at either 40 % or 50 %. But as 
it was not shown in the linearization procedure which the actual input values 
were, the target TIF-file (found in the software’s directory) had to be opened 
and used as a reference. This target TIF did not however contain a 50 % patch, 
instead the 40 % patch had to be used. It appeared as if the dot gain, no matter 
which substrate was used, always by default was set to 13 % for C, M and Y 
and 16 % for K. Even though the tone value increase sometimes was found to 
be negative or greater than 30 percentage units, the dot gain values allowed by 
the software had to be positive integers not greater than 30. When changing 
the dot gain, it was evident that the final linearization step was affected. It is 
not known exactly what the linearization procedure does as some steps are 
traditionally covered by the ICC-profile.

3.12.2 Creation of media profiles

After the base linearization had been performed, an ICC-profile for a specific 
substrate (a media profile) was made using the linearization data, by first 
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printing and then measuring a characterization chart directly from the soft-
ware EFI Color Manager found in EFI Colorproof XF. The default settings (i.e. 
black length 16, black width 10 and gamut mapping “Next closest delta E”) 
were used when generating all media profiles via EFI Colorproof XF.

When trying to use a generated EFI Colorproof XF-media profile in 
Photoshop, it was shown that the profile only worked properly together with 
its linearization profile in EFI Colorproof XF. The linearization profile evi-
dently controls the behaviour of the printer, since the colours differed enor-
mously as when printed from EFI Colorproof XF.

The settings obtained from the linearization and used during the making of 
the ICC-profiles are shown for each proofing media in Annex E.

3.13 Creation of ICC-profiles, using Adobe Photoshop CS3 and 
ProfileMaker 5.0.8

3.13.1 Linearization using EPSON ColorBase v. 2.30

On EPSON’s product web site for EPSON Stylus Pro 3800, a special lineari-
zation (calibration) software could be downloaded and used together with 
the printer – EPSON ColorBase v. 2.30. A linearization profile was made by 
printing and measuring a colour chart (here, printed on the EFI Gravure Proof 
Paper) through the software and then activated, prior to characterization. 
How the linearization process works more exactly is not explained in the user’s 
manual, and when contacting EPSON support, the following information was 
given	in	an	e-mail,	2	June	2009:

”If you are using one printer there is no point in using ColorBase really.  Its really 
for making EPSON printers print the same colours so the Delta E value between 
the printers is normally <1.5.  When using printer without ColorBase you can get 
about Delta E of roughly 2.5 between the printers.  Also the grey values become 
closer to neutral and are not so spread out over the colour space”

Alternatively, it should be possible to make new ICC-profiles instead of per-
forming a (re)calibration if the print outs are found to be unsatisfying after 
a while. The most important factor is that the settings are somewhat stable, 
since the ICC-profile is static and is only applicable, strictly speaking, for the 
very conditions present at the printing for the unique colour chart used for 
characterization.

3.13.2 Settings in the EPSON printing settings window

Before printing from Photoshop, the density settings made in the EPSON 
printer’s printing settings window were always set to zero, but the media 
type was changed to “Proofing Paper Semimatte” when using the semimatte 
proofing substrates, otherwise it was set to “Plain Paper”. The printing quality 
was	set	to	“Quality”,	and	the	mode	was	set	to	“Custom”	and	“Off	(No	Color	
Adjustments)”. EPSON Stylus Pro 3899 uses two types of black inks: Matte 
black and photo black. The matte ink was used when “Plain paper” was used 
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as media type, as it resulted in the richest black (see the gamut in Diagram 2 to 
the right), whilst photo black was used when printing on the semimatte proof-
ing paper (here, the black ink type could not be altered). See Annex G.

3.13.3 Printing from Adobe Photoshop CS3

When printing the characterization chart from Photoshop CS3, no colour 
management was activated in order to send pure CMYK-data to the printer.

3.13.4 Creation of media profiles in MeasureTool 5.0.8 and ProfileMaker 5.0.8

The characterization chart IT8.7-4 (found in ProfileMaker) was measured 
using the iO device in MeasureTool. The characterization data was then used 
in ProfileMaker to generate a colour profile, always using “LOGO Chroma 
Plus” as gamut mapping. The settings for each profile are shown in Annex E.

3.14 Formulae

In the formulae below, subscript 1 denotes the reference value and subscript 2 
denotes the sample.

L*, a* and b* represents the coordinates of a colour in CIELAB.

CIELAB lightness difference ΔL* = L*2 − L*1

 Δa* = a*2 − a*1

 Δb* = b*2 − b*1

The CIELAB chroma, C*ab, of a colour is computed as follows

 C*ab = a*2 + b*2

CIELAB chroma difference ΔC*ab = C*ab2 − C*ab1

CIE 1976 a, b (CIELAB) colour difference, ΔE*ab, between two colours is 
defined as the Euclidean (metric) distance in space between the colour coor-
dinates, using the formula

 ΔE*ab = ΔL*2 + Δa*2 + Δb*2

CIELAB hue difference, ΔH*ab, is determined using the formula3

 ΔH*ab = (ΔE*ab)2 − (ΔL*)2 − (ΔC*ab)2

3 According to the Technical Report 15:2004 (page 18, equ. 8.23) from CIE on colorimetry, 
ΔH*ab should have the same sign as Δhab. This is not mentioned in ISO 13655:1996. Hence, in 
order to conform to the formula from CIE, the ΔH*ab tolerances in ISO 12647-7:2007 should 
instead be regarded as absolute. In this report, the sign of ΔH*ab has been neglected.

Diagram 2 – The black point of 
the gamut for the proofing paper 
from HP, was darker when using 

matte black ink (dark, transparent 
gamut) compared to when using 

photo black ink (coloured gamut).
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4 Results and data

4.1 Data for the proofing substrates

The shades and the gloss of the substrates are shown in Table 3. Additional 
information on the proofing substrates and the paper types listed in ISO 
12647-series are shown in Annex H together with a comparison of the sub-
strates.

Table 3 – The shades and gloss of the proofing substrates. The substrates from 
Kvarnsveden Mill are written in bold face.

Substrate L* a* b* Gloss
%

EFI Gravure Proof Paper 4245 Semimatt 93,26 0,25 −2,19 49,3

EFI Offset Proof Paper 9200 Semimatt 95,19 0,37 −1,84 59,7

EFI Proof Paper ZP 55 (Newspaper Proof) 86,91 −0,68 1,73 13,4

HP Matte Proofing Paper Q1967A 93,14 1,72 −7,83 2,5

NewsPress 1410 82,29 −0,55 2,44 11,9

ExoPress 5710 87,20 −0,87 −0,41 11,1

PubliPress 6740 85,73 −0,94 0,33 53,0

4.2 Colour gamuts for the proofing substrates

In Annex I, the gamuts obtained from Photoshop CS3 and EFI Colorproof XF 
are plotted in 3D. In all the pictures, the Photoshop CS3-gamuts are shown as 
a black lattice structure.

Table 4 and Table 5, on the next page, shows the gamut volumes quanti-
fied for each proofing substrate and simulated ICC-profile, using ColorThink 
Pro.
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Table 4 – The volume of the colour gamut (Vgamut) and the absolute difference in 
gamut volume (|ΔVgamut|) for each proofing system, for each proofing substrate. 
The largest volumes have been written in bold face for each substrate. The unit for 
gamut volume is 13.

Substrate
Vgamut

|ΔVgamut|
EFI Colorproof XF Photoshop CS3

EFI Gravure Proof Paper 4245 Semimatt 737 413 710 989 26 424

EFI Offset Proof Paper 9200 Semimatt 692 804 710 191 17 387

EFI Proof Paper ZP 55 (Newspaper Proof) 124 563 129 941 5 378

HP Matte Proofing Paper Q1967A 263 340 313 788 50 448

NewsPress 1410 101 982 101 022  960

ExoPress 5710 122 671 130 229 7 558

PubliPress 6740 142 327 144 535 2 208

Table 5 – The volume of the colour gamut (Vgamut) for each simulated ICC-profile. 
The unit for gamut volume is 13.

ICC-profile Vgamut

ISOnewspaper26v4 87 524

PSRgravureSC 245 301

PSO SNP Paper 123 241

Germany SNP 93 915

4.3 Colour differences

Table	J:1	to	J:18	in	Annex	J	shows	the	difference	in	colour	between	the	printed	
control strip and the digital reference for each of the profiles on each relevant 
proofing substrate, using EFI Colorproof XF and Photoshop CS3. When the 
difference is greater than the tolerance mentioned in ISO 12647-7:2007, the 
value has been written in bold face.

The patch ID-column refers to the patch position found in the IDEAlliance 
control strip. When evaluating the custom-made profile (Germany SNP), data 
is also shown for the characterization data set found in ISO 12642-2.



Nils Johansson
Degree project – 15 ECTS

Dalarna University – Högskolan Dalarna
Graphic Arts Technology

23

5 Analysis and discussion

5.1 Colour gamuts

As shown in Table 4, the largest gamuts were obtained when using the sub-
strates especially made for ink jet proofing. The production substrates and EFI 
Proof	Paper	ZP	55	(Newspaper	Proof),	produced	significantly	smaller	ones.

As seen in Diagram I:1 to I:7 in Annex I, the gamuts produced by the EFI 
Colorproof XF and Photoshop CS3 differ slightly. Photoshop CS3 obtained for 
instance a larger gamut in the yellow area of the colour space when consid-
ering EFI Gravure Proof Paper 4245 Semimatt, EFI Offset Proof Paper 9200 
Semimatt,	 EFI	 Proof	 Paper	 ZP	 55	 (Newspaper	 Proof)	 and	 ExoPress	 5710,	
while EFI Colorproof XF in general had a larger gamut in the greens–blues.

Table 4 on page 22 shows that EFI Colorproof XF obtained larger gamut 
volumes for EFI Gravure Proof Paper 4245 Semimatt and for NewsPress 1410, 
whilst Photoshop CS3 created larger gamuts for the rest of the substrates 
–	 especially	 for	HP	Matte	 Proofing	 Paper	Q1967A,	where	 the	 difference	 in	
gamut volume was greatest.

The reason for these differences probably lies in the linearization procedure 
in EFI Colorproof XF, during which information is assigned to the generated 
ICC-profile (for instance total ink limit, which in the other case was controlled 
in ProfileMaker after the characterization chart had been measured).

Time could be another factor affecting the gamut, as the time between when 
the colour chart was printed and when it was measured could differ, affecting 
the colour of the chart over time. However, when the fading of the colours was 
measured within 24 hours, the colour differences were within the tolerances 
specified in ISO 12647-7:2007 (i.e. ΔE*ab ≤ 1,5).

Perhaps the gamut mapping method used in EFI Colorproof XF and 
ProfileMaker could alter the shape of the gamut somewhat, explaining these 
differences as well.
As	HP	Matte	Proofing	Paper	Q1967A	contained	a	significantly	higher	UV	

response (see Table H:1, Annex H), a special ICC-profile compensating for the 
optical brighteners (OB) was created and used when printing from Photoshop 
CS3. The gamut volume was however identical to that of the profile with no 
compensation for OB, and when plotted in ColorThink the difference in 
gamut shape was minimal. Therefore, the difference is probably not due to 
that EFI Colorproof XF is compensating somehow for OBs if using the same 
technique as ProfileMaker.

When simply comparing the media gamut volumes with the volumes for the 
simulated ICC-profiles, it is seen that PSRgravureSC could not possibly be a 
subset of any of the production substrates, and cannot be simulated entierly. 
As with the gamut projection dilemma described on page 9, the gamut vol-
umes can only be used to tell if a gamut is not a subset of another gamut – they 
cannot be used, a such, to tell wether it is true that a gamut is a subset.
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5.2 Accuracy of the colour reproduction

Table 6 – Whether or not each proof substrate could simulate each corresponding 
ICC-profile on each proofing system, within the tolerances specified in ISO 12647-
7:2007.
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EFI Gravure Proof Paper 4245 Semimatt ✗ ✗ ✗ ✓ ✗ ✗

EFI Offset Proof Paper 9200 Semimatt ✓ ✗* ✓ ✗* ✓ ✗

EFI Proof Paper ZP 55 (Newspaper Proof) ✗* ✗ ✗ ✗

HP Matte Proofing Paper Q1967A ✗* ✓ ✗ ✗ ✗ ✗ ✗ ✓

NewsPress 1410 ✗* ✗ ✗ ✗

ExoPress 5710 ✗ ✗ ✗ ✗

PubliPress 6740 ✗ ✗

EF
I X

F

PS
 C

S3

EF
I X

F

PS
 C

S3

EF
I X

F

PS
 C

S3

EF
I X

F

PS
 C

S3

 Key: ✗ = at least one colour patch could not meet the tolerance in ISO 12647-7:2007
  ✓ = all colour patches could meet the tolerances in ISO 12647-7:2007
  ✗* = the tolerances were exceeded by ΔE*

ab of max. 1,5 or ΔH*
ab of max. 0,5

 EFI XF = EFI Colorproof XF
 PS CS3 = Photoshop CS3

Only six control strips had a colour difference which was acceptable according 
to the tolerances specified in ISO 12647-7:2007 (not taking the characteriza-
tion data set from ISO 12642-2:2006 into consideration), and five print outs 
failed marginally. Neither of the production substrates had acceptable values, 
nor	did	EFI	Proof	Paper	ZP	55	(Newspaper	Proof).

For EFI Gravure Proof Paper 4245 Semimatt, the difference between EFI 
Colorproof XF and Photoshop CS3 was most dramatic (see Table H:1, H:7 and 
H:12 in Annex H). Nevertheless, as Photoshop CS3 produced colours on this 
substrate which was not that far from the reference colour values, the differ-
ence is probably due to error during the linearization procedure (EFI Gravure 
Proof Paper 4245 Semimatt was the first substrate used for linearization) as 
this dramatic difference was shown in all simulations.

EFI Offset Proof Paper 9200 Semimatt produced colours within the tol-
erances for all the simulated standard profiles when printing from EFI 
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Colorproof XF, and had patches very close to the tolerances when printing 
from Photoshop CS3.
HP	Matte	Proofing	Paper	Q1967A	could	produce	colours	within	the	toler-

ances for ISOnewspaper26v4 and the custom-made profile Germany SNP 
when printing from Photoshop CS3.

Although all the simulated ICC-profiles were a complete subset of the gam-
uts obtained using EFI Gravure Proof Paper 4245 Semimatt and EFI Offset 
Proof Paper 9200 Semimatt on both proofing systems, only the offset proof 
paper from EFI (using EFI Colorproof XF) produced colours within the tol-
erances, as seen in Table 6. If this is not due to error in the measurements, 
this shows that even though the media gamut is larger, this does not mean 
that colours within the gamut will be accurately replicated. This could be due 
to an unstable printing process, the substrate, or due to errors in the gamut 
conversions. However when performing a test on the daily repeatability, the 
control patches printed on each substrate did conform to the tolerances in ISO 
12647-7:2007, 4.2.3 for all the substrates – except for 100 % Y on EFI Gravure 
Proof Paper, and 100 % Y and secondary colour solid blue on EFI Offset Proof 
Paper 9200. Further investigations, possibly including a recalibration, need to 
be carried out to give more reliable results.

5.3 Proofing substrates

When considering the paper qualities for each proofing substrate, of course 
the NewsPress 1410, ExoPress 5710 and PubliPress 6740 are identical to the 
production substrates – but they cannot be used as accurate proofing sub-
strates. Nevertheless, the production substrates’ importance as proof from a 
non-colour accuracy point of view should not be neglected.

The overall paper qualities – like opacity, roughness, gloss, thickness, real 
shade etc. – found in the production substrate cannot be simulated by a proof 
paper especially made for ink jet. Ink jet proofing paper is often much stiffer, 
more opaque, being coated, and having a higher gloss.

This is quite the real dilemma when proofing: The proofing inks, papers and 
proofing method used is often very different from that of the actual printing 
method. From this, one is still trying to replicate a printing result. From a 
strictly colour accuracy point if view, it seems as if the ink jet papers are most 
suitable as proofing substrates, with the largest gamuts.

The EFI proofing paper for newsprint had a slightly smaller colour gamut 
compared to the production substrate ExoPress 5710 but a larger one when 
compared to NewsPress 1410. But as neither media gamut could fully cover 
either of the ICC-profiles tested, it is better to use the actual productions sub-
strates produced by the Mill than using a newsprint proofing substrate which 
has slightly different properties.

From a pure gamut point of view, the proofing substrates made especially for 
ink jet – i.e. EFI Gravure Proof Paper 4245 Semimatt, EFI Offset Proof Paper 
9200	Semimatt	 and	HP	Matte	Proofing	Paper	Q1967A	–	gave	better	 colour	
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simulations and considerable larger gamuts. The gamuts from EFI Gravure 
Proof Paper 4245 Semimatt and EFI Offset Proof Paper 9200 Semimatt con-
fined all the ICC-profiles when viewed in ColorThink and should, theoreti-
cally, be able to simulate the gamuts perfectly.

In ISO 12647-7:2007, 4.2.1 it is said that “[Where the production substrate 
cannot be used as digital proofing substrate,] the digital proofing substrate 
should have the same gloss and CIELAB a* and b* values as the intended 
production substrate within the tolerances listed in Table 1 [i.e. a* ± 2, 
b* ± 2 and gloss ± 15 for glossy substrates and ± 10 for semimatte substrates]”. 
For	 the	 ink	 jet	proof	 substrates,	HP	Matte	Proofing	Paper	Q1967A	matches	
the newsprint substrates (i.e. NewPress 1410 and ExoPress 5710) best when it 
comes to gloss, and EFI Gravure Proof Paper 4245 Semimatt matches the gloss 
of PubliPress 6740, but EFI Offset Proof Paper 9200 Semimatt was very close. 
When it comes to the shades, only EFI Gravure Proof Paper 4245 and EFI 
Offset Proof Paper 9200 were within the tolerances and when having ExoPress 
5710 as substrate reference.

Neither of the production substrates matches the substrate categories found 
in ISO 12647 entirely when it comes to shade and gloss. However, S3 is the 
closes match for NewsPress 1410 and ExoPress 5710, and PubliPress best suits 
PT3 and S2. This could be of interest, as commercial proofing substrates are 
sometimes described in terms of how they suit the different ISO 12647 sub-
strate categories.

For all the ink jet proofing substrates, it is (at least in theory) possible to 
simulate the shades of the production substrates as they are confined within 
all the colour gamuts.4

5.4 The proofing systems

5.4.1 Colour accuracy

EFI Colorproof XF and Photoshop CS3 produced slightly different colour 
gamuts, Photoshop CS3 obtaining the largest gamuts in general. When it 
comes to colour accuracy, EFI had better results when using EFI Offset Proof 
Paper 9200 Semimatt for all the profiles simulated on that substrate – but 
Photoshop CS3 was very close and produced more accurate colours on HP 
Matte	Proofing	Paper	Q1967A.

As only one measurement was made on each substrate for each proofing 
system, it is not possible to tell which proofing system will produce the best 
colours – the risks of errors in the measurements are too significant.

4 The L*a*b* value for each shade of the production paper was simulated in Photoshop CS3. 
The Gamut Warning feature was activated and the shades were simulated using each media 
profile. No gamut warnings occurred, thus the shades are covered by the media gamuts. 
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5.4.2 User’s aspects – convenience

EFI Colorproof is, from a user’s aspect, more convenient when working with 
many different substrates, as the linearization file controls the behaviour of 
the printer, and when importing printing jobs, the workflow with the specific 
settings can be chosen directly.

When printing from Photoshop, alterations need to be made in the printer’s 
settings window when changing substrate – mainly when changing between 
production and ink jet proofing substrates, as the black ink needs to be 
changed to produce the correct gamuts (in EFI Colorproof XF, this is made 
automatically). Also the rendering intent needs to be checked and the correct 
media profile needs to be selected manually – in EFI Colorproof XF, this is 
made automatically when selecting the workflow.

If the ICC-profiles made for Photoshop CS3 are made using the same den-
sity all through, no other changes need to be made in the printer’s settings.

5.4.3 Screening simulation

In EFI Colorproof XF it is possible to also simulate the screening, which is 
not very easy in Photoshop CS3. In this project the screening feature in EFI 
Colorproof XF (a plug-in called Dot Creator) was not tested, but the screening 
simulation is a part of ISO 12647-7:2007.

5.4.4 Margin information

In EFI Colorproof XF, information about the print out (called a job ticket in 
the software, or margin information in ISO 12647-7:2007) can be printed on 
each proof. The margin information states for instance which substrate, ink 
type, ICC-profile and rendering intent was used, together with the time and 
date for print out.

In Photoshop CS3, I have found no such feature. This information is how-
ever very important as it states under which circumstances the proof was 
made and is essential if following ISO 12647-7:2007.

5.4.5 Control strip and colour verification

A colour managed control strip must be printed on each proof, measured and 
compared to the reference values. The result should be attached to the print 
out, together with the tolerances.

In EFI Colorproof XF, such a control strip can be printed automatically and 
verified using the EFI plug-in Color Verifyer.

In Photoshop CS3, the control strip needs to be placed as a part of the 
image to be simulated, manually. No colour verification software is a part 
of Photoshop, but the measurements could easily be made in MeasureTool 
and compared to the reference in that very software, or using for instance 
ColorLab or Microsoft Excel.

In EFI’s Color Verifyer, the reference values are imported automatically, but 
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for MeasureTool, ColorLab and Microsoft Excel, the L*a*b* values need to 
be extracted using the slightly more time consuming methods described in 
Annexes A or B, or alike.
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6 Conclusion and recommendation
Based on the method used in this project, the following conclusions and 
recommendations are made. However, to get more accurate results, the meas-
urements need to be repeated with more print outs and possible more colour 
patches, using each proofing system and calculating an average. Also the 
media profiles need to be based upon further colour charts and the stability of 
the printing process must be investigated further.

6.1 Proofing systems

Using	EFI	Offset	Proofing	Paper	9200	Semimatt	together	with	EFI	Colorproof	
XF produced the best accurate colours, however Photoshop CS3 also pro-
duced colours quite close to the tolerances. Repeating the measurements 
using more print outs and averaging the measured data, and making several 
ICC-profiles with different settings, it is possible that a different result would 
have been reached.

From a user’s point of view, using several printing substrates, EFI Colorproof 
XF is more convenient, with plug-in features such as Dot Creator and Color 
Verifyer. It is also possible to print job tickets and control strips directly from 
the system, which is not possible from Photoshop CS3.

My recommendation is however that Kvarnsveden Mill tries using Photoshop 
CS3, as this is a software which is already used at the Mill, and make colour 
verifications using MeasureTool or Microsoft Excel. If it is later found out that 
the features which are a part of EFI Colorproof XF could be more convenient, 
this software could be used. Both Dot Creator and Color Verifyer are plug-in 
softwares which must be bought separately.

If the proofs should be used as accurate contract proofs, being sent to the 
customer, EFI Colorproof XF is more convenient – but if it’s possible to print 
margin information from Photoshop, or certain well established printing rou-
tines are rigidly followed and conveyed along with the proof, Photoshop CS3 
could be used.

6.2 Substrates

Based on the method used in this project, the conclusion is that neither the 
production	substrates	nor	EFI	Proof	Paper	ZP	55	(Newspaper	proof)	can	be	
used as accurate colour proofing substrates, instead the pure ink jet substrates 
are more suitable for this.

When printing colour proofs, EFI Offset Proof Paper 9200 Semimatt gave 
the most accurate colours and is recommended as the ink jet proofing sub-
strate having a large gamut. It also corresponds quite well with the gloss found 
in PubliPress 6740.
If	desirable,	HP	Matte	Proofing	Paper	Q1967A,	though	containing	optical	

brighteners, could be used as proofing substrate when simulating the newspa-
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per grades with a significantly lower gloss.
The paper shades of NewsPress, ExoPress and PubliPress can all be simulat-

ed on the ink jet proofing paper using the absolute colourimetric conversion.
However, it is recommended that NewsPress 1410, ExoPress 5710, and 

PubliPress 6710 are still used when printing proofs, as they correspond, 
substrate-wise, to the production subtrates. The newspaper grades also had 
colour gamuts quite close to ISOnewspaper26v4 and Germany SNP when 
plotted in 3D.

As commercial proofing substrates often are described in how it suits the 
substrate categories in ISO 12647, the investigation shows that category S3 
best matches NewsPress 1410 and ExoPress 5710, while category PT3 and S2 
best matches PubliPress when it comes to shade and gloss.

Even though the proofing papers made especially for gravure and offset had 
gamuts which completely covered the gamuts of the simulated profiles, they 
did not always obtain colours within the tolerances, which is quite remarkable. 
This could however be due to errors in the measurements, or the printer hav-
ing a low repeatability.
Using	 a	 proofing	 substrate	which	 is	 not	 identical	 to	 the	 production	 sub-

strate, using inks and a printing technique which are not the same as in the 
production process is the the real dilemma of proofing.

Nevertheless, proofing as such is by far more convenient instead of a second 
printing session (in the actual printing process), which saves both time and 
money, giving a good hint of how the final print will appear.

6.3 Suggestions for further investigations and improvements

As a suggestion for further investigation, it would have been interesting to see 
how a test group would react when comparing a proof made on a production 
substrate and on an ink jet proofing substrate, making a visual appraisal on 
which substrate type best represents the final print. The ink jet papers could 
perhaps obtain better colour accuracy when measuring, but the production 
substrates could give a better conformity when just comparing paper quali-
ties.

Also, a more thorough comparison between the characteristics of the gra-
vure, offset and ink jet printing results could be carried out – e.g. the shape 
of the dots, the ink gloss etc. – pointing out limitations of the proofing tech-
nique.

Moreover, an investigation on whether hard or soft proofing technique best 
suits the evaluation of profile could also be investigated.

A special printing target especially made to conform to the requirements in 
ISO 12647-7:2007 could be developed – simplifying the procedure of evaluat-
ing a proofer’s ability to conform to the standard.

As a suggestion for improved features in Photoshop CS3, it would be very 
convenient to be able to print job tickets (margin information) and control 
strips directly from the software.
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Annex A – Obtaining L*a*b* values 
from a control strip using Photoshop

From the Read me-file accompanying the IDEAlliance Control Strip. This method is conven-

ient when a smaller amount of patches are being measured, otherwise the method using 

ColorLab is recommended (see Annex B).

Photoshop CS3

1. Open the control strip in Photoshop CS3 and assign the ICC-profile you want to simu-

late (Edit→Assign Profile...).

2. Make sure that Absolute Colorimetric is set as intent in Edit→Color Settings...→More 

options. These settings affect the L*a*b* values.

2. In the Info palette, click the eye dropper icon and choose Lab Color.

3. Move the cursor over the patch. The L*a*b* value of the patch is shown in the Info 

window.

Sometimes, L*a*b* values are needed with more decimal places, which is not shown in 

Photoshop CS3 directly. To obtain this, click the eye dropper icon and choose 16-bit.

Calculate the L*a*b* values using the formulae

 L* = L*
16-bit/327,68 e.g. L* = 13066/327,68 ≈ 39,87

 a* = a*
16-bit/128 e.g. a* = −1261/128 ≈ −9,85

 b* = b*
16-bit/128 e.g. b* = −1091/128 ≈ −8,52
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Annex B – Obtaining L*a*b* values
from a control strip using ColorLab

ColorLab

ColorLab can export the L*a*b* values for a control strip or the like if the image is made up from 

single pixels representing each patch. ColorLab can also export characterization data as an image.

ColorLab is a freeware which can be downloaded from X-Rite’s website.

Make a TIF-file from characterization data

1. Open the colour data text file describing the colour patches in ColorLab. The colour data text 

file looks something like this:

LGOROWLENGTH 2  ← the number of patch-rows 
NUMBER_OF_FIELDS 4 ← the number of data columns

BEGIN_DATA_FORMAT

CMYK_C CMYK_M CMYK_Y CMYK_K ← explanation of the contents written in each column below

END_DATA_FORMAT  “BEGIN_DATA” – in this case cyan, magenta, yellow and black

NUMBER_OF_SETS 54 ← the number of patches

BEGIN_DATA

100 0 0 60 ← the values for each column, here 100 % cyan, 0 % magenta,

100 100 0 60 0 % yellow and 60 % K

...

30  30 0 0

END_DATA

2. In ColorLab, click File→Switch to reference. This changes the colour mode to CMYK.

3. Click File→Export and save the data as a TIF-file. The TIF-file now consists of pixels in 

untagged CMYK data.

Note that this procedure just has to be done once per control strip. The TIF-file can be reused 

in Photoshop.

Exporting the L*a*b* values from a control strip in TIF

1. Open the control strip TIF-file (which was created in the earlier steps) in Photoshop, and 

assign a colour profile (Edit→Assign Profile...). This will be the reference.

2. Convert the image to L*a*b* using Edit→Convert to Profile...→Destination space: Lab Color. 

Make sure Absolute Colorimetric is used as intent and Use Dither is disabled.

3. Save the image as TIF, using no image compression.

4. Open the TIF in ColorLab. Choose Filter→Layout and Format→Spot Colors.... Click Enable and 

then OK.

5. Export the L*a*b* values as a colour data text file (similar to the text seen above) from 

File→Export. The text file can be opened in for instance Microsoft Excel and the L*a*b* val-

ues in the LAB_L, LAB_A and LAB_B columns can be extracted and used as reference when 

measuring the colour accuracy of the proof, or opened and set as reference in MeasureTool or 

ColorLab.
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Annex C – Information about the 
SpectroDens instrument from Techkon
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Bilaga 1 – Information om SpectroDens från
Techkons användarmanual
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Annex D – Information about the
Eye-One Pro (i1 Pro) from X-Rite
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Annex E – Settings for each media profile

The settings for each media profile in EFI Colorproof XF and ProfileMaker 5.0.8.

For all media profiles in EFI Colorproof XF, the black length was set to 16, the black width 
was set to 10, together with the gamut mapping “Next closest delta E”.

In ProfileMaker, the gamut mapping “LOGO Chroma Plus” was used.

EFI Gravure Proof Paper 4245 Semimatte
EFI Colorproof XF

Total ink limit: 268
Cyan ink limit: 80
Magenta ink imit: 95
Yellow ink limit: 90
Black ink limit 96
Dot gain, 40 %: C 23 %, M 9 %, Y 8 %, K 12 %

ProfileMaker
GCR: 4
Black start 0 %
Black width 100
Max K: 100 %
Max CMYK: 200 %

EFI Offset Proof Paper 9200 Semimatte
EFI Colorproof XF

Total ink limit: 283
Cyan ink limit: 70
Magenta ink imit: 90
Yellow ink limit: 90
Black ink limit 96
Dot gain, 40 %: C 20 %, M 11 %, Y 7 %, K 13 %

ProfileMaker
GCR: 4
Black start 0 %
Black width 100
Max K: 100 %
Max CMYK: 200 %

EFI Proof Paper ZP 55 (Newspaper proof )
EFI Colorproof XF

Total ink limit: 263
Cyan ink limit: 90
Magenta ink imit: 90
Yellow ink limit: 90
Black ink limit 92
Dot gain, 40 %: C 14 %, M 0 %, Y 4 %, K 21 %

ProfileMaker
GCR: 4
Black start 0 %
Black width 100
Max K: 100 %
Max CMYK: 200 %

HP Matte Proofing Paper Q1967A
EFI Colorproof XF

Total ink limit: 385
Cyan ink limit: 85
Magenta ink imit: 95
Yellow ink limit: 100
Black ink limit 100
Dot gain, 40 %: C 11 %, M 5 %, Y 0 %, K 25 %

ProfileMaker
GCR: 4
Black start 0 %
Black width 100
Max K: 100 %
Max CMYK: 200 %
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NewsPress 1410
EFI Colorproof XF

Total ink limit: 273
Cyan ink limit: 90
Magenta ink imit: 90
Yellow ink limit: 95
Black ink limit 90
Dot gain, 40 %: C 16 %, M 6 %, Y 0 %, K 22 %

ProfileMaker
GCR: 4
Black start 0 %
Black width 100
Max K: 100 %
Max CMYK: 150 %

ExoPress 5710
EFI Colorproof XF

Total ink limit: 278
Cyan ink limit: 90
Magenta ink imit: 90
Yellow ink limit: 90
Black ink limit 89
Dot gain, 40 %: C 15 %, M 0 %, Y 0 %, K 21 %

ProfileMaker
GCR: 4
Black start 0 %
Black width 100
Max K: 100 %
Max CMYK: 150 %

PubliPress 6740
EFI Colorproof XF

Total ink limit: 227
Cyan ink limit: 80
Magenta ink imit: 95
Yellow ink limit: 95
Black ink limit 86
Dot gain, 40 %: C 16 %, M 6 %, Y 0 %, K 22 %

ProfileMaker
GCR: 4
Black start 0 %
Black width 100
Max K: 100 %
Max CMYK: 150 %
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Annex F – IDEAlliance Digital Control Strip

80 70 70 10010.2 7.4 7.4 100 100 100100 100 60 100 100 70 70 30 30 100 100 60 100 100 100 10070 70 30 30 100 100 60 70 70 4070 70 30 30 100 40 100 40 40 100 10 40 40 20 70 70 3.1 2.2 2.270 40 40 75 66 6650 40 4025 19 19B 0 0 0 0

100 70 30 100 10 25 50 75 90 100100 60 100 70 30 100 60 40 70 4070 30 100 40 40 100 40 100 40 70 40 70 40 40  340 70 40 70 40 40100 60A

3%ISO 12647-7 Digital Control Strip 2009

ISO 
12642-2
patch ID

% C % M % Y % K
ISO 

12642-2
patch ID

% C % M % Y % K

A1 1091 100 0 0 60 B1 1095 100 100 0 60

A2 73 100 0 0 0 B2 81 100 100 0 0

A3 55 70 0 0 0 B3 61 70 70 0 0

A4 28 30 0 0 0 B4 31 30 30 0 0

A5 1075 0 100 0 60 B5 1175 0 100 100 60

A6 9 0 100 0 0 B6 657 0 100 100 0

A7 7 0 70 0 0 B7 493 0 70 70 0

A8 4 0 30 0 0 B8 247 0 30 30 0

A9 1171 0 0 100 60 B9 1191 100 0 100 60

A10 649 0 0 100 0 B10 721 100 0 100 0

A11 487 0 0 70 0 B11 541 70 0 70 0

A12 244 0 0 30 0 B12 271 30 0 30 0

A13 397 100 0 40 0 B13 77 100 40 0 0

A14 45 40 100 0 0 B14 333 0 100 40 0

A15 653 0 40 100 0 B15 685 40 0 100 0

A16 1023 0 40 70 40 B16 338 10 40 40 0

A17 999 0 70 40 40 B17 511 20 70 70 0

A18 959 40 70 0 40 B18 1024 0 70 70 40

A19 1031 40 0 70 40 B19 1011 70 0 40 40

A20 963 70 40 0 40 B20 1 0 0 0 0

A21 1365 0 0 0 3 B21 — 3,1 2,2 2,2 0

A22 1362 0 0 0 10 B22 — 10,2 7,4 7,4 0

A23 1359 0 0 0 25 B23 — 25 19 19 0

A24 1356 0 0 0 50 B24 1611 50 40 40 0

A25 1353 0 0 0 75 B25 — 75 66 66 0

A26 1350 0 0 0 90 B26 729 100 100 100 0

A27 1260 0 0 0 100 B27 — 80 70 70 100

A

B

A

B

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27

The IDEAlliance Digital Control Strip (also known as Color Control Wedge)
can be downloaded, for free, from www.idealliance.com
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Annex G – The EPSON printing settings
window

The EPSON printing settings window.

The density settings used for all media profiles.
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Annex H – Proofing substrates and the 
substrate categories from the ISO 12647-series
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Table H:2 – The deviation in shade and gloss (ΔG) between the production sub-
strates, the proofing substrates and the ISO 12647 substrate categories.

Proofing substrates Substrate categories ISO 12647

EF
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ng
 

Pa
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67

A

PT
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PT
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PT
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PT
4

PT
5

S1 S2 S3 S4 Ty
pi

ca
l n

ew
sp
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nt

N
ew

sP
re

ss
 1

41
0

ΔL* 10,97 12,90 4,62 10,85 7,71 6,71 1,71 6,71 2,71 5,71 3,71 3,71 0,71 0

Δa* 0,80 0,92 −0,13 2,27 0 0 0 0 0 0 0 0 0 0

Δb* −4,63 −4,28 −0,71 −10,27 −3,44 −3,44 0 −3,44 1,56 −3,44 0 0 0 0

ΔG (%) 37,40 47,80 1,50 −9,40 48,10 21,10 38,10 −0,90 −0,90 43,10 33,10 0 −1,90 −6,90

Ex
oP

re
ss

 5
71

0 ΔL* 6,06 7,99 −0,29 5,94 2,80 1,80 0 1,80 0 0,80 0 0 0 −4,20

Δa* 1,12 1,24 0,19 2,59 0 0 0 0 0 0 0 0 0 0

Δb* −1,78 −1,43 2,14 −7,42 −0,59 −0,59 1,41 −0,59 4,41 −0,59 0,41 1,41 1,41 2,41

ΔG (%) 38,20 48,60 2,30 −8,60 48,90 21,90 38,90 −0,10 −0,10 43,90 33,90 0 −1,10 −6,10

Pu
bl

iP
re

ss
 6

74
0 ΔL* 7,53 9,46 1,18 7,41 4,27 3,27 0 3,27 0 2,27 0,27 0,27 0 −2,73

Δa* 1,19 1,31 0,26 2,66 0 0 0 0 0 0 0 0 0 0

Δb* −2,52 −2,17 1,40 −8,16 −1,33 −1,33 0,67 −1,33 3,67 −1,33 0 0,67 0,67 1,67

ΔG (%) −3,70 6,70 −39,60 −50,50 7,00 −10 0 −42,00 −42,00 2,00 0 −23,00 −43,00 −48,00
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Annex I – Colour gamuts from 
EFI Colorproof XF and Photoshop CS3

Diagram I:1 – Gamut obtained using EFI Gravure Proof Paper 4245 Semimatt as 
proofing substrate. The solid in colour represents the gamut obtained from EFI 
Colorproof XF, the black lattice structure represents the gamut obtained from 
Photoshop CS3.
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Diagram I:2 – Gamut obtained using EFI Offset Proof Paper 9200 Semimatt as 
proofing substrate. The solid in colour represents the gamut obtained from EFI 
Colorproof XF, the black lattice structure represents the gamut obtained from 
Photoshop CS3.
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Diagram I:3 – Gamut obtained using EFI Proof Paper ZP 55 (Newspaper Proof ) 
as proofing substrate. The solid in colour represents the gamut obtained from 
EFI Colorproof XF, the black lattice structure represents the gamut obtained from 
Photoshop CS3.
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Diagram I:4 – Gamut obtained using HP Matte Proofing Paper Q1967A as proofing 
substrate. The solid in colour represents the gamut obtained from EFI Colorproof 
XF, the black lattice structure represents the gamut obtained from Photoshop 
CS3.
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Diagram I:5 – Gamut using NewsPress 1410 as proofing substrate. The solid in 
colour represents the gamut obtained from EFI Colorproof XF, the black lattice 
structure represents the gamut obtained from Photoshop CS3.
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Diagram I:6 – Gamut using ExoPress 5710 as proofing substrate. The solid in 
colour represents the gamut obtained from EFI Colorproof XF, the black lattice 
structure represents the gamut obtained from Photoshop CS3.
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Diagram I:7 – Gamut using PubliPress 6740 as proofing substrate. The solid in 
colour represents the gamut obtained from EFI Colorproof XF, the black lattice 
structure represents the gamut obtained from Photoshop CS3.
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Annex J – Evaluation of colour reproduction

ISOnewspaper26v4

Table J:1 – The colour differences between the proof and the digital data for each 
proofing system. Profile: ISOnewspaper26v4. Proof substrate: EFI Gravure Proof 
Paper 4245 Semimatt.

Patch ID
EFI Colorproof 

XF
Photoshop 

CS3
ISO

tolerances

Simulated print substrate colour B20

ΔE*
ab 4,61 4,12 ≤ 3

100 % C A2

ΔE*
ab 11,80 2,57 ≤ 5

ΔH*
ab 4,64 1,06 ≤ 2,5

100 % M A6

ΔE*
ab 10,25 10,94 ≤ 5

ΔH*
ab 0,63 2,08 ≤ 2,5

100 % Y A10

ΔE*
ab 9,51 3,61 ≤ 5

ΔH*
ab 8,09 2,28 ≤ 2,5

100 % K A27

ΔE*
ab 7,51 1,14 ≤ 5

ΔH*
ab 1,72 0,29 ≤ 2,5

All patches in control strip A1–B27

maximum ΔE*
ab 16,62 13,83 ≤ 6

average ΔE*
ab 10,19 4,88 ≤ 3

Grey balance patches B21–B26

average ΔH*
ab 3,81 0,51 ≤ 1,5
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Table J:2 – The colour differences between the proof and the digital data for each 
proofing system. Colour profile: ISOnewspaper26v4. Proof substrate: EFI Offset 
Proof Paper 9200 Semimatt.

Patch ID
EFI Colorproof 

XF
Photoshop 

CS3
ISO

tolerances

Simulated print substrate colour B20

ΔE*
ab 1,03 2,08 ≤ 3

100 % C A2

ΔE*
ab 2,31 3,83 ≤ 5

ΔH*
ab 1,71 0,11 ≤ 2,5

100 % M A6

ΔE*
ab 1,76 4,87 ≤ 5

ΔH*
ab 1,24 3,27 ≤ 2,5

100 % Y A10

ΔE*
ab 0,60 3,52 ≤ 5

ΔH*
ab 0,50 1,57 ≤ 2,5

100 % K A27

ΔE*
ab 2,21 1,95 ≤ 5

ΔH*
ab 0,95 1,38 ≤ 2,5

All patches in control strip A1–B27

maximum ΔE*
ab 2,52 4,87 ≤ 6

average ΔE*
ab 1,42 2,65 ≤ 3

Grey balance patches B21–B26

average ΔH*
ab 0,40 1,45 ≤ 1,5
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Table J:3 – The colour differences between the proof and the digital data for each 
proofing system. Profile: ISOnewspaper26v4. Proof substrate: EFI Proof Paper ZP 
55 (Newspaper proof).

Patch ID
EFI Colorproof 

XF
Photoshop 

CS3
ISO

tolerances

Simulated print substrate colour B20

ΔE*
ab 0,71 1,67 ≤ 3

100 % C A2

ΔE*
ab 1,06 2,81 ≤ 5

ΔH*
ab 0,18 2,37 ≤ 2,5

100 % M A6

ΔE*
ab 3,30 8,56 ≤ 5

ΔH*
ab 1,12 1,33 ≤ 2,5

100 % Y A10

ΔE*
ab 2,67 2,39 ≤ 5

ΔH*
ab 0,13 0,52 ≤ 2,5

100 % K A27

ΔE*
ab 2,72 0,92 ≤ 5

ΔH*
ab 0,48 0,35 ≤ 2,5

All patches in control strip A1–B27

maximum ΔE*
ab 7,29 9,79 ≤ 6

average ΔE*
ab 2,05 3,12 ≤ 3

Grey balance patches B21–B26

average ΔH*
ab 0,37 0,21 ≤ 1,5
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Table J:4 – The colour differences between the proof and the digital data for each 
proofing system. Profile: ISOnewspaper26v4. Proof substrate: HP Matte Proofing 
Paper Q1967A.

Patch ID
EFI Colorproof 

XF
Photoshop 

CS3
ISO

tolerances

Simulated print substrate colour B20

ΔE*
ab 0,44 1,52 ≤ 3

100 % C A2

ΔE*
ab 1,67 1,84 ≤ 5

ΔH*
ab 0,57 0,51 ≤ 2,5

100 % M A6

ΔE*
ab 1,06 1,17 ≤ 5

ΔH*
ab 0,06 0,27 ≤ 2,5

100 % Y A10

ΔE*
ab 1,59 4,01 ≤ 5

ΔH*
ab 1,37 0,36 ≤ 2,5

100 % K A27

ΔE*
ab 1,51 2,18 ≤ 5

ΔH*
ab 1,31 0,46 ≤ 2,5

All patches in control strip A1–B27

maximum ΔE*
ab 7,34 4,70 ≤ 6

average ΔE*
ab 1,69 1,89 ≤ 3

Grey balance patches B21–B26

average ΔH*
ab 0,47 0,25 ≤ 1,5
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Table J:5 – The colour differences between the proof and the digital data for each 
proofing system. Profile: ISOnewspaper26v4. Proof substrate: NewsPress 1410.

Patch ID
EFI Colorproof 

XF
Photoshop 

CS3
ISO

tolerances

Simulated print substrate colour B20

ΔE*
ab 1,37 0,94 ≤ 3

100 % C A2

ΔE*
ab 3,84 2,98 ≤ 5

ΔH*
ab 2,53 1,21 ≤ 2,5

100 % M A6

ΔE*
ab 4,81 8,65 ≤ 5

ΔH*
ab 2,33 2,46 ≤ 2,5

100 % Y A10

ΔE*
ab 1,64 2,00 ≤ 5

ΔH*
ab 0,14 1,68 ≤ 2,5

100 % K A27

ΔE*
ab 2,03 1,62 ≤ 5

ΔH*
ab 0,54 0,04 ≤ 2,5

All patches in control strip A1–B27

maximum ΔE*
ab 6,82 8,92 ≤ 6

average ΔE*
ab 2,83 2,80 ≤ 3

Grey balance patches B21–B26

average ΔH*
ab 0,43 0,32 ≤ 1,5
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Table J:6 – The colour differences between the proof and the digital data for each 
proofing system. Profile: ISOnewspaper26v4. Proof substrate: ExoPress 5710.

Patch ID
EFI Colorproof 

XF
Photoshop 

CS3
ISO

tolerances

Simulated print substrate colour B20

ΔE*
ab 1,59 1,91 ≤ 3

100 % C A2

ΔE*
ab 3,25 2,82 ≤ 5

ΔH*
ab 2,31 1,69 ≤ 2,5

100 % M A6

ΔE*
ab 3,14 7,75 ≤ 5

ΔH*
ab 0,60 1,07 ≤ 2,5

100 % Y A10

ΔE*
ab 5,76 3,45 ≤ 5

ΔH*
ab 0,87 0,18 ≤ 2,5

100 % K A27

ΔE*
ab 2,44 0,70 ≤ 5

ΔH*
ab 1,02 0,00 ≤ 2,5

All patches in control strip A1–B27

maximum ΔE*
ab 8,19 10,61 ≤ 6

average ΔE*
ab 3,28 3,13 ≤ 3

Grey balance patches B21–B26

average ΔH*
ab 0,84 0,14 ≤ 1,5
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PSO SNP Paper

Table J:7 – The colour differences between the proof and the digital data for each 
proofing system. Profile: PSO SNP Paper. Proof substrate: EFI Gravure Proof Paper 
4245 Semimatt.

Patch ID
EFI Colorproof 

XF
Photoshop 

CS3
ISO

tolerances

Simulated print substrate colour B20

ΔE*
ab 4,86 1,84 ≤ 3

100 % C A2

ΔE*
ab 9,90 1,74 ≤ 5

ΔH*
ab 4,12 0,23 ≤ 2,5

100 % M A6

ΔE*
ab 7,61 3,66 ≤ 5

ΔH*
ab 0,56 2,35 ≤ 2,5

100 % Y A10

ΔE*
ab 9,93 3,80 ≤ 5

ΔH*
ab 7,56 2,14 ≤ 2,5

100 % K A27

ΔE*
ab 6,15 2,36 ≤ 5

ΔH*
ab 3,64 0,02 ≤ 2,5

All patches in control strip A1–B27

maximum ΔE*
ab 16,06 4,45 ≤ 6

average ΔE*
ab 9,44 1,95 ≤ 3

Grey balance patches B21–B26

average ΔH*
ab 4,09 0,45 ≤ 1,5
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Table J:8 – The colour differences between the proof and the digital data for each 
proofing system. Profile: PSO SNP Paper. Proof substrate: EFI Offset Proof Paper 
9200 Semimatt.

Patch ID
EFI Colorproof 

XF
Photoshop 

CS3
ISO

tolerances

Simulated print substrate colour B20

ΔE*
ab 0,39 2,30 ≤ 3

100 % C A2

ΔE*
ab 2,04 5,78 ≤ 5

ΔH*
ab 1,12 1,23 ≤ 2,5

100 % M A6

ΔE*
ab 2,19 3,92 ≤ 5

ΔH*
ab 1,81 2,97 ≤ 2,5

100 % Y A10

ΔE*
ab 0,14 4,55 ≤ 5

ΔH*
ab 0,13 2,00 ≤ 2,5

100 % K A27

ΔE*
ab 2,07 1,20 ≤ 5

ΔH*
ab 0,88 0,02 ≤ 2,5

All patches in control strip A1–B27

maximum ΔE*
ab 4,01 5,78 ≤ 6

average ΔE*
ab 1,46 2,62 ≤ 3

Grey balance patches B21–B26

average ΔH*
ab 0,45 1,49 ≤ 1,5
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Table J:9 – The colour differences between the proof and the digital data for each 
proofing system. Profile: PSO SNP Paper. Proof substrate: EFI Proof Paper ZP 55 
(Newspaper proof).

Patch ID
EFI Colorproof 

XF
Photoshop 

CS3
ISO

tolerances

Simulated print substrate colour B20

ΔE*
ab 0,63 1,23 ≤ 3

100 % C A2

ΔE*
ab 6,47 7,57 ≤ 5

ΔH*
ab 0,79 2,50 ≤ 2,5

100 % M A6

ΔE*
ab 11,34 13,68 ≤ 5

ΔH*
ab 3,26 0,66 ≤ 2,5

100 % Y A10

ΔE*
ab 12,96 15,43 ≤ 5

ΔH*
ab 2,21 1,51 ≤ 2,5

100 % K A27

ΔE*
ab 10,55 7,23 ≤ 5

ΔH*
ab 2,99 0,83 ≤ 2,5

All patches in control strip A1–B27

maximum ΔE*
ab 18,27 21,59 ≤ 6

average ΔE*
ab 6,02 6,73 ≤ 3

Grey balance patches B21–B26

average ΔH*
ab 0,86 1,02 ≤ 1,5
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Table J:10 – The colour differences between the proof and the digital data for 
each proofing system. Colour profile: PSO SNP Paper. Proof substrate: HP Matte 
Proofing Paper Q1967A.

Patch ID
EFI Colorproof 

XF
Photoshop 

CS3
ISO

tolerances

Simulated print substrate colour B20

ΔE*
ab 0,36 1,02 ≤ 3

100 % C A2

ΔE*
ab 1,29 0,90 ≤ 5

ΔH*
ab 0,63 0,27 ≤ 2,5

100 % M A6

ΔE*
ab 3,05 1,75 ≤ 5

ΔH*
ab 0,10 0,44 ≤ 2,5

100 % Y A10

ΔE*
ab 2,32 2,65 ≤ 5

ΔH*
ab 0,22 0,27 ≤ 2,5

100 % K A27

ΔE*
ab 2,27 1,50 ≤ 5

ΔH*
ab 0,30 0,75 ≤ 2,5

All patches in control strip A1–B27

maximum ΔE*
ab 12,17 8,83 ≤ 6

average ΔE*
ab 2,94 2,51 ≤ 3

Grey balance patches B21–B26

average ΔH*
ab 0,62 0,32 ≤ 1,5
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Table J:11 – The colour differences between the proof and the digital data for each 
proofing system. Profile: PSO SNP Paper. Proof substrate: ExoPress 5710.

Patch ID
EFI Colorproof 

XF
Photoshop 

CS3
ISO

tolerances

Simulated print substrate colour B20

ΔE*
ab 1,59 1,72 ≤ 3

100 % C A2

ΔE*
ab 7,85 8,22 ≤ 5

ΔH*
ab 4,59 1,35 ≤ 2,5

100 % M A6

ΔE*
ab 11,06 13,51 ≤ 5

ΔH*
ab 1,85 0,33 ≤ 2,5

100 % Y A10

ΔE*
ab 14,72 18,81 ≤ 5

ΔH*
ab 1,49 1,90 ≤ 2,5

100 % K A27

ΔE*
ab 9,69 8,46 ≤ 5

ΔH*
ab 1,91 0,53 ≤ 2,5

All patches in control strip A1–B27

maximum ΔE*
ab 17,76 25,40 ≤ 6

average ΔE*
ab 7,20 7,33 ≤ 3

Grey balance patches B21–B26

average ΔH*
ab 1,04 0,77 ≤ 1,5
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PSRgravureSC

Table J:12 – The colour differences between the proof and the digital data for each 
proofing system. Profile: PSRgravureSC. Proof substrate: EFI Gravure Proofing 
Paper 4245 Semimatt.

Patch ID
EFI Colorproof 

XF
Photoshop 

CS3
ISO

tolerances

Simulated print substrate colour B20

ΔE*
ab 1,83 2,26 ≤ 3

100 % C A2

ΔE*
ab 10,65 3,36 ≤ 5

ΔH*
ab 6,14 1,52 ≤ 2,5

100 % M A6

ΔE*
ab 6,48 3,03 ≤ 5

ΔH*
ab 3,89 2,70 ≤ 2,5

100 % Y A10

ΔE*
ab 9,75 5,47 ≤ 5

ΔH*
ab 8,58 4,19 ≤ 2,5

100 % K A27

ΔE*
ab 5,53 0,78 ≤ 5

ΔH*
ab 3,25 0,75 ≤ 2,5

All patches in control strip A1–B27

maximum ΔE*
ab 16,51 7,87 ≤ 6

average ΔE*
ab 8,48 2,34 ≤ 3

Grey balance patches B21–B26

average ΔH*
ab 3,53 0,61 ≤ 1,5



Nils Johansson
Degree project – 15 ECTS

Dalarna University – Högskolan Dalarna
Graphic Arts Technology

61

Table J:13 – The colour differences between the proof and the digital data for each 
proofing system. Profile: PSRgravureSC. Proof substrate: EFI Offset Proof Paper 
9200 Semimatt.

Patch ID
EFI Colorproof 

XF
Photoshop 

CS3
ISO

tolerances

Simulated print substrate colour B20

ΔE*
ab 0,53 1,70 ≤ 3

100 % C A2

ΔE*
ab 2,18 5,90 ≤ 5

ΔH*
ab 0,94 0,93 ≤ 2,5

100 % M A6

ΔE*
ab 1,49 3,51 ≤ 5

ΔH*
ab 1,10 2,67 ≤ 2,5

100 % Y A10

ΔE*
ab 1,48 5,56 ≤ 5

ΔH*
ab 1,03 3,55 ≤ 2,5

100 % K A27

ΔE*
ab 2,77 0,63 ≤ 5

ΔH*
ab 1,30 0,27 ≤ 2,5

All patches in control strip A1–B27

maximum ΔE*
ab 5,84 8,12 ≤ 6

average ΔE*
ab 1,70 3,15 ≤ 3

Grey balance patches B21–B26

average ΔH*
ab 0,48 1,19 ≤ 1,5
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Table J:14 – The colour differences between the proof and the digital data for each 
proofing system. Profile: PSRgravureSC. Proof substrate: HP Matte Proofing Paper 
Q1967A.

Patch ID
EFI Colorproof 

XF
Photoshop 

CS3
ISO

tolerances

Simulated print substrate colour B20

ΔE*
ab 0,67 1,44 ≤ 3

100 % C A2

ΔE*
ab 4,51 1,61 ≤ 5

ΔH*
ab 1,76 0,71 ≤ 2,5

100 % M A6

ΔE*
ab 14,71 12,64 ≤ 5

ΔH*
ab 0,28 0,58 ≤ 2,5

100 % Y A10

ΔE*
ab 9,44 12,86 ≤ 5

ΔH*
ab 0,41 2,05 ≤ 2,5

100 % K A27

ΔE*
ab 8,71 7,48 ≤ 5

ΔH*
ab 1,54 2,34 ≤ 2,5

All patches in control strip A1–B27

maximum ΔE*
ab 26,73 21,88 ≤ 6

average ΔE*
ab 6,29 5,67 ≤ 3

Grey balance patches B21–B26

average ΔH*
ab 0,20 0,47 ≤ 1,5
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Table J:15 – The colour differences between the proof and the digital data for each 
proofing system. Profile: PSRgravureSC. Proof substrate: PubliPress 6740.

Patch ID
EFI Colorproof 

XF
Photoshop 

CS3
ISO

tolerances

Simulated print substrate colour B20

ΔE*
ab 0,93 0,93 ≤ 3

100 % C A2

ΔE*
ab 13,96 8,71 ≤ 5

ΔH*
ab 1,22 0,38 ≤ 2,5

100 % M A6

ΔE*
ab 20,22 21,48 ≤ 5

ΔH*
ab 2,01 0,58 ≤ 2,5

100 % Y A10

ΔE*
ab 17,73 26,21 ≤ 5

ΔH*
ab 2,51 1,94 ≤ 2,5

100 % K A27

ΔE*
ab 14,06 11,13 ≤ 5

ΔH*
ab 1,05 0,64 ≤ 2,5

All patches in control strip A1–B27

maximum ΔE*
ab 32,49 45,57 ≤ 6

average ΔE*
ab 8,68 10,30 ≤ 3

Grey balance patches B21–B26

average ΔH*
ab 0,61 0,72 ≤ 1,5
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Germany SNP (custom-made ICC-profile)

Table J:17 – The colour differences between the proof and the digital data for each 
proofing system. Profile: Germany SNP (custom-made). Proof substrate: HP Matte 
Proofing Paper Q1967A.

Patch ID
EFI Colorproof 

XF
Photoshop 

CS3
ISO

tolerances

Simulated print substrate colour B20

ΔE*
ab 0,09 2,28 ≤ 3

100 % C A2

ΔE*
ab 1,68 2,72 ≤ 5

ΔH*
ab 0,64 0,62 ≤ 2,5

100 % M A6

ΔE*
ab 0,55 1,93 ≤ 5

ΔH*
ab 0,27 1,10 ≤ 2,5

100 % Y A10

ΔE*
ab 0,72 4,85 ≤ 5

ΔH*
ab 0,54 0,39 ≤ 2,5

100 % K A27

ΔE*
ab 1,45 2,45 ≤ 5

ΔH*
ab 0,99 0,80 ≤ 2,5

All patches in control strip A1–B27

maximum ΔE*
ab 8,24 4,85 ≤ 6

average ΔE*
ab 1,69 2,04 ≤ 3

Grey balance patches B21–B26

average ΔH*
ab 0,31 0,39 ≤ 1,5

Outer gamut patches —

average ΔE*
ab 1,69 1,98 ≤ 4

All patches of ISO 12642-2 —

average ΔE*
ab 1,80 1,90 ≤ 4

95 % percentile ΔE*
ab 4,29 4,01 ≤ 6
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Table J:18 – The colour differences between the proof and the digital data for each 
proofing system. Profile: Germany SNP (custom-made profile). Proof substrate: 
NewsPress 1410, using relative colorimetric conversion (i.e. no substrate simula-
tion). Black ink simulation was activated when printing from Photoshop.

Patch ID
EFI Colorproof 

XF
Photoshop 

CS3
ISO

tolerances

Simulated print substrate colour B20

ΔE*
ab (0,23)† (0,18)† ≤ 3

100 % C A2

ΔE*
ab 4,25 5,14 ≤ 5

ΔH*
ab 3,05 2,33 ≤ 2,5

100 % M A6

ΔE*
ab 6,80 11,37 ≤ 5

ΔH*
ab 2,80 2,67 ≤ 2,5

100 % Y A10

ΔE*
ab 1,33 1,67 ≤ 5

ΔH*
ab 0,54 1,21 ≤ 2,5

100 % K A27

ΔE*
ab 2,25 1,70 ≤ 5

ΔH*
ab 0,36 0,21 ≤ 2,5

All patches in control strip A1–B27

maximum ΔE*
ab 7,20 11,37 ≤ 6

average ΔE*
ab 2,69 2,73 ≤ 3

Grey balance patches B21–B26

average ΔH*
ab 0,37 0,28 ≤ 1,5

Outer gamut patches —

average ΔE*
ab 2,58 2,70 ≤ 4

All patches of ISO 12642-2 —

average ΔE*
ab 2,26 2,19 ≤ 4

95 % percentile ΔE*
ab 4,10 4,80 ≤ 6

† Not applicable since the proofing substrate is identical to the production substrate
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